
ResEdit for Fun and Productivity
By Francine Schwieder

Before setting out on a ResEdit adventure there are some safety precautions that must be
followed. Really. Although you cannot break your Mac using the keyboard and mouse--as long
as you don't unplug either while the computer is running--you can wreck any program you use
ResEdit on, and, since this includes the operating system itself, you can do some serious
damage which could result in the loss of important data and the necessity of calling a guru to
help you get up and running again. But if you follow basic safety precautions, then using
ResEdit can make your system behave the way you want it to and thus increase the usability
of your Mac. You can get ResEdit almost anywhere fine downloads are offered on the
Internet, including Apple's own site. But first those truly necessary precautions:
1. Back everything up all the time. This should be done whether you ever use ResEdit or not.
You should have at least 3 copies of anything you don't want to lose or couldn't replace
easily. One copy will be on your hard drive, the other two should be on two different sorts of
media, if that is at all possible. For instance you could have a copy of a text file on a floppy
and on a zip drive, or on tape and a CD. Bear in mind that these days floppies are almost
useless. The iMac and new G3s don't even have floppy drives, and hardly any new programs
will fit on a floppy, not to mention most graphics files. So invest in some sort of removable
media drive that you can hook to your machine and back those files up! The more room on
the drive you select the better. My system folder at the moment is 173MBs which means it
doesn't fit on a zip cartridge, so I keep current copies of it on two zips and once a month
back up everything in the system and anything new to a CD. A good CD burner costs around
$500 (or less if you do some shopping around and don't want a rewritable drive) and regular
CD-R media is $2 or less per disk.
2. Know how to start your computer by some means other than the internal drive! The
easiest method is to use your original OS CD. Restart your computer with the CD in the CD
drive and hold down the "c" key while the computer restarts. It will reboot from the CD. Then
you can fix whatever you did wrong. You can also make an emergency restart floppy disk
using Norton Utilities. To force your machine to restart simply hold down the command and
control keys and hit the Power On/Off button. Try restarting your computer using an
alternate method before you monkey with anything to make sure you know how to do it and
that the method you have selected actually works.
3. Always use ResEdit on a copy of the file you want to alter, and always keep a copy of the
original somewhere handy in case your change turns out to have some unforseen bad effect.
You can make a copy easily by selecting the file, then option-click-drag to wherever you want
the file you are working on to reside. Or select the file, hit command-d and drag the resultant
"myfile copy" to wherever you want. Remember: make a copy, work on the copy, save the
original.
4. Take notes on what you've done. You'll be glad you did at some future date when you
either want to reverse things or do them a little differently, or if you do a clean install and
want to recreate something you had done before. Or, of course, if what you did doesn't work
you'll want to know what to avoid doing next time and try something different.
Here are some things to never, ever do while using ResEdit:



1. Never work on a file that is running.
2. If ResEdit crashes while you are working on a file never attempt to use that file. Trash it
and start over. It has almost certainly been corrupted.
3. Never use ResEdit on the only copy you have of a file. If it crashes while you are working
(and ResEdit is prone to crashes) you are in serious trouble. Remember that each change you
make with ResEdit is made on the spot. If you decide you don't want that change ResEdit
then goes back and restores the original state. So if you are interrupted before you have a
chance to tell ResEdit to save or not to save, your changes are all already in place in the file.
And the interruption, whether a crash or power outage, has probably corrupted the file
anyway.
OK, everyone ready? Let's modify the Finder. First, create a folder on your drive, call it
MyFinders. Open your system folder and option-click and drag the Finder icon onto this
folder. You will now have a copy of the Finder to work on inside the MyFinders folder. Launch
ResEdit and click on the Jack-in-the-Box to make him go away and get the Open dialog box.
Move to the MyFinders folder and select Finder. Open it. Make sure you are opening your
copy and not the original! You will have a window open in ResEdit that has a bunch of icons
with 4 letter names under them.

The first illustration happens to be a screen capture of the window for the Finder in OS8.1,
which is slightly different from earlier and later versions. The little icons represent the
different resources present in the Finder. These resources are the things we are going to
modify. The first thing I do after installing a new system is to add command-T to the Special
Menu so I can empty the Trash from the keyboard rather than using the mouse. I will use that
modification as an example for adding different keyboard commands to your Finder menus.
Click on the resource "fmn2" in OS8 or OS8.5, in OS7.5.5 and OS7.6 it is called "fmnu." A
new window opens on top of the Finder resources window. This window has a list of all the
individual resources in fmn2. There are three columns, the first being the ID number, then the
size of the resource, and finally the name (which is blank for the Finder fmn2s). If you are
operating on OS8 you will want to select the resource with ID 524 to get to the Special
Menu. In OS8.5 it is ID 525, and in 7.5.5 and 7.6 it is ID 1255. When you open it you get an
intimidating window full of weird characters. Don't panic! Editing this hex code is easy,



although it can cause eye strain.

The first column in the illustration can be ignored. The next four columns are hex code. Scary
isn't it? The last column contains a translation of the hex code into something faintly
resembling the English language. If you peer at it for a time you will begin to recognize words.
The first word is "Special" and the next fully formed words are "Empty Trash." In the
accompanying illustration you will notice that the third space in front of "Empty Trash" is the
letter T. This is my modified Finder. When you look at your Finder resource in ResEdit you will
see that the third space in front of "Empty Trash" is occupied by a place holder thingy.
Running in any OS before 8.5 the place holder is kind of "0" shaped, but if you are working in
OS8.5 the place holder will be like this ^ (which caused me some consternation the first time
I used ResEdit with OS8.5). Click the mouse cursor between the second and third place
holder, then carefully drag your mouse over the third character to select it. You will notice
that a pair of zeroes in the hex code gets simultaneously selected with a little box drawn
around them. If your selection is bigger than this try again. You want only the third character
in front of "Empty Trash" to be selected and a 00 pair boxed. Now hold down the shift key
and type a T. The place holder thingy has been replaced by your capital T (which looks better
in the menu than a lower-case one, or so the GUI designers think), and the hex code has
changed from "00" to "54." That's it. You've edited the hex code for the Special Menu. Save
your changes and quit.
Create a folder called OriginalFinder, open your System Folder and drag the Finder to this
folder. Open the MyFinders folder and drag your modified Finder (or option drag to leave you
with something to go on playing with later) into the System Folder. Restart. When you go to
the Special menu you will see a new command-T keyboard shortcut listed for Empty Trash.
Put something in the Trash and hit command-T and you get the Empty Trash dialog box. Hit
return and the Trash is emptied without moving your hands off the keyboard.
You can customize your menu command key shortcuts to your heart's content using this
method. Just make sure you don't pick a letter that is already in use! For instance, if you
want to make command-R a keyboard shortcut to restart your computer, you must first open
the fmn2 resource for the File menu and change the R in front of Show Original to some
other unused letter (I changed it to G). You can then go back to the Special menu resource
and add the R in front of Restart. Pretty neat! Of course this particular modification can lead
to some mishaps if you happen to use Command-R for something else. I use it habitually to
reload web pages. If you think you're in the program, but are actually in the Finder and hit
Command-R you will watch with some consternation as your computer restarts.



As you open and explore the resources for Finder menus you will notice that there seem to
be a double set. The simpler ones are for the Simple Menu option (if you don't use it you
may have forgotten it exists). You'll want to edit the ones that already contain command key
shortcuts. This will also help you remember where to place your changes. Third character in
front of the menu item you're changing.
There are several other command key combinations that I've added to my OS. In the View
menu for OS8.x you have a number of options for how the Finder displays its open windows.
At the top are three choices: as Icons, as Buttons, or as List. In OS 8.5 you can set a global
default preference for your windows by going to the Edit menu, Preferences, and then
selecting the Views tab. There is a drop-down menu in the resultant window where you then
set the display preferences for Icons, Buttons, and List view. Your settings here apply to all
windows for which you have not specified custom settings. What if you have a window open
that is set to Icon view, but at this moment you want it to display as a List so you can have
the items arranged in alphabetical order? Or arranged by date modified? You could use your
mouse to go up to the View menu, select List, do what you want, then use the mouse to go
back to the menu and restore your settings. Or you could click in the window while holding
down the control key, go to View in the resultant contextual menu and select it with your
mouse. If you change window views very often this mousing around gets to be a pain. Instead
use ResEdit to add the following command key shortcuts: K for Icons (the letter I is already in
use for Get Info, and C for Copy, so I thought K would work best), B for Buttons and the
letter L for List. Now when you want to change views you can do so from the keyboard. A
friend of mine with much computer experience, but a horror of ResEdit, was using my
computer one day and conceded that this was a truly useful change.
To make these changes in OS8.x, you open the copy of your Finder with ResEdit. Now select
the resource fmn2 and open ID number 524 (in OS8.5, see Illustration). In OS 8.1 the ID
number is 523. In any case you will know if you have the correct menu resource open
because the words you can read at the right side will say "View" and "as Icons" and so on.
Remember: to assign your new command key letters you carefully select the place holder that
is the third one in front of the menu item you are changing. Hold down the shift key and type
the letter you want to use as the command key shortcut. You can use the Illustration as a
guide as it already contains my improvements. Save your changes.



There are other resources one can change as well, though the changes I always make are
more a matter of taste than something practical. For instance STR# ID 4000, item number 1
in the OS8.5 Finder displays the rather boring message, "The application Ò^2Ó has
unexpectedly quit, ^1." Well one doesn't ever expect the application to quit, so why not
change this rather moronic message? In your open ResEdit window highlight the words "has
unexpectedly quit" and substitute something that makes more sense. When I have an
application quit the dialog box displays the message, "The application Ò^2Ó has wigged out,
^1." And my STR# 4000, number 11, now reads "The application Ò^2Ó has wigged out, ^1.
You should save your work in other open applications and restart the computer." You may
find this equally moronic, or impossibly sophomoric, but you can make the message read
whatever you want. In OS8.5 the default name given a new folder is located in STR# 4500
item number 3. Personally I think "untitled folder" is both uninspired and takes up too much
space. When I make a new folder it begins life as "nameless." As you explore the STR#
resource you may find a number of things you want to change. Just don't change any of the
weird looking things, such as "^2" because this is a direction to the Finder to plug-in some
specific information. If your change doesn't seem to do anything you may have to search
other STR# resources and also the STR resource for other occurrences of the phrase you
want modified. One of the things I also like to do is change "About this Computer" at the top
of the Apple menu to "Francine's Computer." But I'm not quite sure which change actually
works. "About this Computer" appears not only in the STR# resource but other places as well,
including fmnu2 ID 521. I just poke around until I've changed everything I can find to
"Francine's Computer" and get the result I want. Since you are working on a copy of the
Finder feel free to open everything and see what's inside. Just don't use that copy if you
change something you don't understand or you get a crash!
After you've made the changes you want you can then drag the original Finder out of the
System folder, put it somewhere safe, and put your modified Finder into the System folder
and restart. Your customized Finder is now running the show.



There are things you can do with the System also, and I always make one alteration when I
install a System upgrade: I substitute my own startup screen. So make a folder, let's call it
MySystem, and make a copy of your System (it is inside the System Folder, of course) and
place your copy in the MySystem folder. Launch ResEdit and open this copy. My, isn't that
impressive! Did you ever see so many resources in one place before? If you like you can open
the "snd" resources, and then get ResEdit to play the mysterious ones (the window shade
sound is ID -120234 in System 8.5) by selecting the sound you would like to hear, and then
either hitting command-T or picking "Play Sound" from the snd menu.
To change the start screen you want to open the PICT resource. Select it and open by double
clicking. Scroll down to resource -16506, in OS 8.5, and double click again, and then copy
this pict to the scrapbook. When you do you will see that the scrapbook gives the dimensions
(422 by 323) of the image in pixels. Now open your painting program and create something
you want, that is that size. Remember to leave a border around the image where the
"Welcome to Mac" text appears. Copy your masterpiece, go back to ResEdit, and double click
the picture -16506 if you closed it. Paste your piece into this window, close it and save. To
get the text to match, go to resources -20235 and -20241. Note what they say. Copy one
to the scrapbook, make a new graphic that size, fill with a color that matches the border of
your splash screen, and add some text. Personally I make both say "Let us begin" in Gothic
type. But you can do whatever appeals to you. When you've finished, copy, open the
resource, and paste your replacement. Obviously you can alter any or all of the other picts
that you find here as well. Just be sure your replacement is the same size.
As long as we are making some custom pictures, how about the Finder? Again, make a copy
of the Finder, open with ResEdit, and double click the PICT resource. You'll see two picture
resources, ID 4000 and 4001. These are the pictures that appear when you select "About
this Computer" or, in my case, "Francine's Computer" from the Apple menu when the Finder
is active. If you've been real thorough editing the STR and STR# resources in the Finder, the
window that opens when you select this will also be titled "My Very Own Computer" (or
whatever you chose to call it). Now you can also make the pictures your own custom
productions as well. Follow the exact same procedure as above.
When you have finished all your wonderful changes, move the System and Finder files out of
the System Folder, stash them somewhere safe--but don't put both of them together in the
same folder somewhere on your startup drive! Your Mac will get very confused and think you
have two System Folders or something, and then you may have to see if your alternate way
of starting up really works. Replace the originals with your new, improved models in the
System Folder (and if your copies said "copy" at the end of the name, be sure to remember
to delete that). Now restart and watch your own opening graphic and comments appear.
Once up and running select the "About the Computer" from the Apple menu and admire your
graphic work here as well. Ain't this fun?
Oh, and if you noticed the screen capture shots above looked a little strange, that's because
I'm also unable to resist Ka le idoscopeKa le idoscope, which is reputed to also be a risky program to use.
Personally, I love it. Not only does my Mac act the way I want, but it looks the way I want,
too. But that is a whole 'nother column. Meanwhile, if you've decided to give ResEditing a go,
you might want to visit the ResExce l l ence  S i te .ResExce l l ence  S i te .  It is full of good advice and fun hacks.
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